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Sample Table tab
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Injection Table tab
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The Sample Table items

Specify the items (columns) to appear in the Sample Table. é
Use the Default button to select typical settings, Select :
All to view all the items, and Select None to clear the
selections.
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Specify the items (columns) to appear in the Injection
Table. Use the Default button to select typical settings,
Select All to view all the items, and Select None to clear
the selections.
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Statistics Table tab
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The Statistics Table items

Specify the items (columns) to appear in the Statistics
Table. Use the Default button to select typical settings,
Select All to view all the items, and Select None to clear
the selections.

Maintenance

The Maintenance sub-menu

Zero Point Detection

This procedure determines the zero point of the
syringe. Before conducting zero point detection,
place a TOC grade water-filled vial in position S1 of
the turntable. Zero point detection starts after the
sampling needle moves to the S1 vial. When zero
point detection is completed, the ASI-5000 arm and
needle return to the home positions.

Regeneration of TC Catalyst

As samples are analyzed, inorganic substances
deposit on the surface of the catalyst, decreasing
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sensitivity and data reproducibility. Catalyst
efficiency can be restored with the injection of
dilute hydrochloric acid (HCI) into the catalyst.

Before starting regeneration of the TC catalyst,
place a vial containing 2N HCl in position S1.
Regeneration of the TC catalyst starts after the
sampling needle moves to the S1 vial. The 2N HCI
is injected into the TC combustion tube several
times.

The sampling needle then moves to the rinse water
receptacle and the flow line from the sampling
needle to the TC injection needle is washed three
times with water from the rinse water receptacle.

Regeneration of IC Solution

With repetitive sample analysis, the acidity of the
IC solution gradually decreases. Regeneration of
the IC solution pumps IC reagent to the IC reaction
vessel.

Sample Volume Count

Totals the volume of injected sample (not
standards) for TC analysis. This is used in
combination with the External Scrubber Unit
(ESU) optional accessory.

Residue Removal
Select this command to remove residue from the
flow lines and syringe. The status bar indicates the
progress of the procedure.

TOC Control Software Manual

116

Residue removal in progress

Washing

Choose whether to clean the flow lines to the TC,
IC, or POC. Select OK when finished.

Select OK when finished

Mechanical Check

Select Mechanical Check to open the Mechanical
Check dialog box, shown below.

The Mechanical Check dialog box
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TOC Tab

Syringe Pump Slider
Use the arrows to move the syringe plunger up and
down. Click RESET to move the plunger to the
highest position.

Injection Port

Choose TC to move the TC sliding injection block
with needle (alternates direction). Choose 1C to
move the IC sliding block with needle.

Solenoid Valves

Turn the IC Drain, Carrier Gas, Sparge Gas, and
Acid on and off using the ON and OFF buttons
below the appropriate title.

Port Select

To open the line between the syringe and an
injection port, choose the appropriate port from the
buttons in this area of the dialog box. Choose IC,
TC, AUX, or SMPL (Sampling Tube).

ASI Tab

The ASI Tab becomes available when ASI Used is checked
on the ASI tab of the Options/Instrument Conditions
dizlog box.

R T R
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The ASI tab e Mechanijcal Check dialog bo
Rinse

Use the ON and OFF buttons to start and stop ASI
flow line rinsing.

Move Turntable

Use the START and SToP buttons to move the ASI
turntable.

ASi Pause

When Start is selected, the ASI finds all its home
positions, then returns to its home position.

Arm

Use UP, MIDDLE, and DOWN to move the arm
vertically. Use the spin controls for fine vertical
adjustments. The RIGHT and LEFT buitons move
the arm in a horizontal direction.

Arm Position
Choose V1 to move the arm directly above Vial 1.

Choose RINSE to move the arm directly above the
rinse water receptacle.

Choose S1 to move the arm directly above vial S1.

Choose V43/V2 to move the arm directly above
either Vial 43 (when using a regular sensitivity
vial) or V2 (when using a high sensitivity vial).
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» Note:

SSM Tab

The SSM Tab becomes available when SSM Used 1s
checked on the SSM tab of the Instrument Conditions
dialog box. Select Options/Instrument Conditions to open
this dialog box.

The SSM tab of the Mechanical Check dialog box

For more information about the SSM, refer to the SSM
manual.

SSM Power

A check mark in this field indicates that the SSM
Power is on.

Sample Change Position (TC)

A check mark in this field indicates that the TC
sample boat 1s in the default (sample change)
position.

Measurement Position (TC)
A check mark in this field indicates that the TC
sample boat has moved to the measurement
position.

Sample Change Position (IC)
A check mark in this field indicates that the IC
sample boat has moved to the default (sample
change) position.

TOC Contro! Software Manual
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Measurement Position (IC)

A check mark in this field indicates that the IC
sample boat has moved to the measurement
position.

SSM TC Furnace Ready

A check mark in this field indicates that the SSM
TC furnace temperature is ready.

SSM IC Furnace Ready

A check mark in this field indicates that the SSM
IC furnace is ready.

Aux

A check mark in this position indicates the
Auxiliary port connection has been made.

SSM TC Furnace Control

A check mark in this field indicates the TC Furnace
control is on.

SSM IC Furnace Control

A check mark in this field indicates the IC Furnace
control is on.

Cooling Fan Control
A check mark in this field indicates the Cooling

Fan control is on.
Aux1-5

A check mark in this field indicates the Auxiliary
Port connections have been made.
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POC Tab

echanical Chec

The POC tab of the Mechanical Check Dialog box

The POC Tab becomes available when POC Option is
checked on the TOC tab of the Instrument Conditions
dialog box. (Select Options/Instrument Conditions to open
this dialog box.)

Carrier Gas On/Off

Open the carrier gas valve by turning the Carrier
Gas On. Turn off the Carrier gas by selecting Off.

Sparge Gas On/Off

Select the On button to open the sparge gas valve
and Off to stop the flow of sparge gas.

Drain On/Off
Choose On to open the Drain Valve and Off to close
the valve.

Maintenance Menu (continued)

Initialize ASI
This operation is performed when first connecting the
instrument. It establishes communication between the
software program and the ASL

#= Note: Removing the needle is recommended before performing
this procedure for the first time.

Change Syringe
This command prepares the syringe for removal. Follow

the instructions on-screen to specify the new syringe
volume and change the syringe.

TC Blank Settings

The TC blank check automatically determines the
background level of the instrument. This is normally
conducted upon installation and when changing the
catalyst. A sample of reagent water is injected into the TC
combustion tube and the condensed water is collected in a
purified water trap. All carbon in the purified water has
been removed. The purified water is then re-injected into
the TC combustion tube and the area is measured. This is
repeated several times.

Follow the on-screen instructions to complete the
procedure.

The on-screen instructions guide you through the procedure

= Note; This check requires approxima tely four hours to complete.

rs- Note: This check can only be performed when high-sensitivity
catalyst is in use.
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PC Configuration

e

The PC Configuration dialog bo

" Data Path

Enter a default path for data files in the Data Path
text box. To select a path from the Select Directory
dialog box, click BROWSE.

Cal Curve Path

Enter a default path for calibration curve files in
the Cal Curve Path text box. To select a path from
the Select Directory dialog box, click BROWSE.

Method Path

Enter a default path for method files in the Method
Pathtext box. To select a path from the Select
Directory dialog box, click BROWSE.

Config File

Enter a default path and file name for the
configuration file in the Config File text box. To
select a path and file name from the Open dialog
box, click BROWSE. For more information on the
configuration file, see The prm file, p. 4.

Validation

Enter a default path and file name for the
validation file in the Validation text box. To select
a path and file name from the Open dialog box,
click BROWSE

New Directory

Select a new path from the Select Directory dialog
box by clicking the NEW DIRECTORY button.

Set Instrument Date/Time

b

Set Instrument T ims

The Set Date/Time dialog box

To set the instrument date and time select SET.

Save Configuration

Select Save Configuration to save the Instrument
Conditions (visible by selecting Options/Instrument
Conditions).

The first time the TOC Control program is used, a .prm
file must be specified when this command is executed.
When the Save dialog box is opened using this command,
the Save File as Type field 1s set to the Parameter File
type (prm extension). Select a path and enter a file name
for the new prm file. For more information on the settings
in the prm file, see p. 4.

!nstru-ment Status

The instrument status indicates the current status of the
instrument and its connected compoenents. Alternatively,
open each box individually by selecting the items from the
instrument status bar.
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TOC

Basehne Pos.: 11 4
Baseline Fluct: 0K
Baseline noize: [1].4
Fumace temp: DK
Caoler temp: OK

The TOC Status dialog box

TC Furnace: OK
IC Fuinace: . 1] 4
Spl. boat T(: oK
Spl. boat IC; 11,4

The 55M Status dialog box

The ASI Status dialog box

TOC Control Software Manual

Export Menu

The Export Menu allows you to create data files in
formats that are compatible with other programs.

ASCII

Before selecting this item, use the ASCII Export Options
dialog box (see p.128) to specify which data items to

export.

The Export Save As dialog box

Then, use this command to open the Export Save As
dialog box. Enter a file name and specify the directory for
the file (see File/Save As on p. 51 for a description of the
Network button). Then select OK, and an ASCII text file
containing the selected data items is created in the

specified location.
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ASCII Export Options
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This command specifies the items to be exported by the
ASCII command. The items are divided into tabs. Each
tab has DEFAULT, SELECT ALL, and SELECT NONE buttons.
Use these buttons to facilitate the selection process; the
DEFAULT button selects items most commonly chosen for
export.

General tab

The General Tab contains all the information from the
Options/General Information dialog box (see p. 105). Also
on this tab are the current Instrument Conditions. These
1tems come from the Options/Instrument Conditions
dialog box (see p. 105). In addition to these items, the
Instrument Attachments shows the model numbers of the
instrument and the ASI or SSM.

Cal Curves tab

Select items for export relating to the Calibration Curve.
These items come from the Calibration Curve dialog box.

Samples tab

Select items for export related to the samples. The
Sample information comes from the Sample Table. The
Injections information is from the Injection Table.
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Statistic Table tab

Select items for export related to sample statistics. These
items come from the View/ Statistics (Summary) window
(see p.89).

Miscellaneous tab

Specify a separator (delimiter) for cell text from the drop-
down box. Choices include: Tab, Comma, Colon,
Semicolon, or Space. Enable the checkbox to enclose text
strings in quotation marks. (This is useful for programs
which require all text strings to be isolated by quotation
marks.)

Database

5 I
QL:'?‘-E i Exced Files

N FoxPro Files iy
MS Access 97 Database
4 Text Files

-
e
ST S : T

The SQL Data Sources dialog box

The Database command opens the SQL (Structured
Query Language) Data Sources dialog box. Here, you can
export to any commercial database which supports 16-bit
ODBC (Open Database Connectivity) format, like dBase,
FoxPro, MS Access, or Paradox.

Choose NEW to specify the data source name. The Add
Data Source dialog box opens. Choose the appropriate
driver for the database installed on your system. The
ODBC setup dialog box opens. Enter the data source
name, description, and database information. Choose OK
to return to the SQL Data Sources dialog box.

Select the desired data source for export. Click OK. The
current sample run is exported.
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11. Window Menu

The Window menu

Cascade

Stack all open windows so the title bars are visible using
the Cascade command.

Tile
Choose Tile to size all open windows so each occupies an
equal portion of the screen.

Arrange lcons

Choose Arrange Icons to neatly organize windows reduced
to 1cons.

Close
Closes the current window.

12. Help Menu

The help menu

Contents

Select Contents to open the table of contents for the help
file.

Search for help on
Select this menu command to search the help file.

About Tocentr

Select About to view software registration and version
information.
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Chapter Five

Sample Table

The Sample Table is used to set up a data run. Use the
Auto Generate, Insert Standard, Insert Control, or Insert
Sample functions on the Edit menu to add new unknowns
and samples to the chart.

For more information on the Auto Generate function, see
p. 65. For more information on the Insert Standard
function, see p.67. For more information on the Insert
Sample function, see p. 68.

Changing Column Width

Type

To change the column width, hold the mouse over the
border on the title cell. The cursor changes to two lines
with arrows in the middle. Click, then drag the cell border
to the desired width.

To automatically adjust the column width to
accommodate the longest entry, double-click when the
cursor changes to two lines with arrows.

The type of analysis is displayed in this column (Standard,
Unknown, Control, or Trk Control).

Sample Name

The Sample Name column displays the descriptive name
for the sample. The same name can be used for several
samples.

Sample ID

Method

The Sample ID column displays the descriptive identifier
for the sample.

The Method column displays the method file used for this
sample.
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6.

10.

11.

12,

13.

Analysis
' Displays TC, IC, or NPOC analysis types. For more
information on these analysis types, see p. 4.

Vial
Enter/displays the vial number in the Via/column. This
column does not appear for SSM measurement.,

No. Injections

Displays the number of injections performed. This
number is always 1 for SSM measurement.

-Max No. of Injections

The Max No. of Injections column shows the maximum
number of injections to be performed, if measurement
must be re-conducted (because the SD and/or CV max.
values were exceeded).

This column is not available for SSM measurement.

Sparge Time
This is the sparge time specified for the measurement (for

NPOC analysis). This column does not appear for SSM
measurement.

Dilution
This is the dilution factor specified in the method.

No. Washes

This is the number of rinses specified for the
measurement. This does not appear for SSM
measurement.

Injection Volume

The injection volume from the method or calibration is
displayed in this column.

TOC Control Software Manual

14.

15.

16.

17.

18.

19.

20.

Acid Addition

The volume of acid added to the sample prior to sparging
1s displayed (generally for NPOC analysis).

SD Max

When the SD Max limit is exceeded, the instrument
automatically re-injects the current sample until the
measurement 1s within the limit or the maximum number
of injections is reached. An injection that exceeds the SD
Max is excluded. (This does not appear for SSM
measurement.)

CV Max

When the CV Max limit is exceeded, the instrument
automatically re-injects the current sample until the
measurement is within the limit or the maximum number
of injections is reached. An injection that exceeds the CV
Max is excluded. (This does not appear for SSM
measurement.)

Amount (mg)

Enter/displays the amount of sample in mg for SSM
samples.

Volume ()

Enter/displays the volume of sample for SSM samples.

Density (mg/ul)

Displays the sample density for SSM samples.

Cal Curve 1, 2, and 3

These fields display the Calibration Curve file names. See
Appendix Bfor more information on how the program
chooses a calibration curve from among the three listed.

For SSM analysis, only one calibration curve is displayed.
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21. Range

The range which was used to analyze the
samples/standards is displayed here.

22. Mean Area

The Mean Area column displays the average of the area
counts.

23. CNV

This item displays the result of the following
equation:

area of " measurement x weight {volume) of standard in n" measurement
weight (volume) of standard in first measurement

The SD and CV values are calculated according to
the converted area values displayed here. This
column does not appear for ASI measurement.

24. Abs C

Shows the absolute carbon value for SSM measurement.

25. Conc

This is the caleulated concentration of the sample in the
units selected. Note that if the Confidence Range item is
selected in the Sample Table tab (Options/ Display
Settings), the confidence interval (calculated according to
DIN38402) is shown in addition to the concentration. ‘

26. Unit

The unit of concentration selected for the analysis is
displayed here. '

27. Result

The Result calculates the TOC concentration, which 1s
either the TC measurement minus the IC measurement
(TOC = TC-IC) or the POC measurement plus the NPOC
measurement (TOC = NPOC + POC), depending on the
rocasurement type selected.
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28.

29.

30.

31.

32.

33.

34.

35.

SD

The SD column displays the standard deviation of the
concentrations. See p. 76 for more information on the
standard deviation calculation.

Ccv

The CV column displays the coefficient of variation of the
concentrations. See p. 76 for more information on the
coefficient of variation calculation.

SD Area

The SD column displays the standard deviation of the
area counts. See p. 76 for more information on the
standard deviation calculation.

CV Area

The CV column displays the coefficient of variation of the
area counts. See p. 76 for more information on the
coefficient of variation calculation.

Modified

An M appears in the Modified column if the data has been
modified after it was collected.

Excluded

An E appears in the Excluded column if the data was
excluded from calculations.

Remark

The software generates remarks for certain samples, such
as Revision 23 samples.

Comment

A comment is displayed in this column.
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36. Date/Time

The date and time at which the injection was performed
displays in the Date/Time column.

138

Chapter Six Injection Table

1.

The injection table shows detailed information about the
ijections from one row of the Sample Table.

To open an Injection Table, click in the Sample Table row
to be examined. Then, select Injections from the View

menu, or click the Injection Table button in the
Toolbar. The Injection Table opens, with three sections of
injection information: the Table, the Graph, and the
results of the Outlier Test.

Injection Table

The table columns can be customized to display only
certain columns by enabling the desired items in the
Options/ Display Settings/ Injections Tab.

Type . '
The type of sample (from the Sample Table) is
shown: Standard, Unknown, Control, or Trk
Control.

Sample Name, Sample ID

The name of the sample and sample ID (from the
Sample Table) is shown.

Analysis
The type of analysis (TC, IC, TOC, NPOC, NPwI)
used for the injection is shown (see p. 4 for a
description of these analyses).
Injection No.
The injection number is shown in order of injection.
Vial

The vial number for the injection is shown. This
column does not appear for SSM measurements.
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Injection Table

Cal Curve Range value is automatically adjusted and the
The calibration curve used for calculation is shown. sample is re-injected.
The concentration of the injection is calculated .
. B: Baseline
based on this curve. ) )
The baseline was not stable during measurement.
Dilution F: Furnace
Dilutions made, if any, are shown here. This is a The furnace temperature fluctuated outside the
multiplier for the concentration value. If no acceptable range during measurement.
dilution was made, the multiplier is 1.0000.
C S: Solution
Inj. Vol. Auto-regeneration of the IC solution has occurred.
The injection volume (from the Sample Table) is )
displayed. This column does not appear for SSM Unit
injections. The unit of measurement (from the Sample Table)
is displayed.
Range
The range (from the Sample Table) is shown. If the Modified
range 1s automatically changed during o When the operator uses the Recalculate function
measurement (for ASI), the new value is displayed (Edit/Recalculate), an M appears in this column,
here. indicating that the data has been modified after
measurement.
Date/Time
The Date and Time of the injection are displayed. Exciuded
If an injection was excluded from calculation
Notes because it exceeded the detector’s linear response,
Remarks about the injection are made here. or the SD Max anffoﬁ CV Max, this will be shown
here as the letter “E.” To manually exclude an
T: Tailing Peak injection, select the row, then Edit/Exclude. Save
The peak end point was not detected within a tlﬁetﬁle undef 1§s;1ew1nim1}el. TE nicl&lde an mje((i:tmn
specified period of the start point (about 4.5 min for at was excluded, select the hxclude comman
TC and 3.5 min for IC). agam.
H: Height - Area
The peak height exceeded the working range of the b The area count for the injection is displayed. At the
detector by a large amount. If the peak height bottom of this column, the Mean (MV) area count,
exceeds full scale, the injection amount is reduced : Standard Deviation (SD)} and Coefficient of
in an attempt to obtain the peak on-scale. _ Variation (CV) are shown. For more information on
' these items, see p. 76.
h: height
The peak exceeded the working range of the
detector by a small amount. When this occurs, the
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Conc

Amount

Volume

CNV

ug C

The calculated concentration is displayed here; the
calculation is based on the displayed calibration
curve and is also shown in the graph on the right.
At the bottom of the column, the Mean
concentration value is displayed.

The amount of sample (in mg) from the Sample
Table is given here when the SSM is used. This
column appears only for a SSM measurement.

The SSM volume, from the Sample Table, is given
here. This column appears only for a SSM
measurement.

The CNV value from the Sample Table appears
here when the SSM is used.

This column appears only for a SSM measurement.

This shows the pg Carbon in a sample when the
SSM is used. This column appears only for a SSM
measurement.

Injection Graph

The Injection Table window graph shows a plot of area
counts for each injection. If the graph is hidden, enable
the display in the Options/ Display Settings/ Injection
Table tab.

Each point on the graph represents one injection. Note
that outliers are indicated differently. Five lines on the
graph help with statistical interpretation: the mean, and
one and two times the standard deviation above and
below the mean.

The appearance of the graph can be customized, and more
detailed information about the graph can be obtained.
(This is also true of the Statistics (Summary) graph, and

TOC Control Software Manual

Copy

Cross-hair

to a lesser extent, the Peak Profile graph, Calibration
Curve graph, and Baseline Profile graph.)

To customize and manipulate the graph, click on the
graph with the right mouse button. The Graph menu
appears.

The Graph menu

This copies the graph onto the clipboard. The
bitmap can then be pasted into other applications.

From the sub-menu that appears, select Display to
extend the cross-hairs and display detailed axis
information at the cross-hair position. Select Lock
to freeze the extended cross-hairs in position. Undo
either of these actions by selecting the item again.
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Fonts ' Line Colors

Opens the Colors dialog box, where the colors and
types of annotation for the graph can be changed.

- Atlantic Inline
A AvantGarde Bk BT :H

R ™

. b .
The Font dialog box The Colors dialog box

This opens the Font dialog box, where graph text
style, si1ze, and color can be changed to customize |
the graph’s appearance. ; Click on one of the items to be changed in the Data
field (for example, the Mean value line). With the
item highlighted, select the new color, line type, or
annotation type. Note that line types are in the
first row of the bottom left box, and annotation
types are in the bottom row.

»- Note: The a ppéarance of this dialog box varies with the graph.

Limits
Opens the Graph Limits dialog box, where upper
and lower limits for values of the X and Y axis can
be changed, so that the scale of the graph display

changes. To hide the line or annotation, select the first box

In the appropriate row.

Select OK once the items have been customized.
The graph displays with the new settings.

Options
The Options command opens the Options dialog

box. Here, a grid can be selected, along with grid
options and graph background color.

The Graph Limits dialog box

Enter new values, then select OK. The graph
display changes according to the new limits. To
restore the graph to its original appearance, open
the dialog box, select Reset, then OK.
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e R e

Customize the graph’s appearance with the Options dialog box

Grid Lines

From the drop-down box, select from None, Major,
or Major & Minor. The Major selection will draw
the grid lines at major unit divisions. The Major &
Minor selection will draw grid lines at both major
and minor unit divisions.

In addition to the grid, major (rounded} and minor
tick marks can be drawn to indicate unit divisions.
With no grid, both major and minor tick marks can
be selected. With a2 major grid, minor tick marks
can be selected.

Grid Color

The color of the grid lines can be selected from the
drop down list.

Line Type

Choose the line type for the grid lines from the drop .

down list.

Background Color

m Note:

Radar

Choose the background color for the graph from the
drop down list.

Do not choose the same color for the grid, line colors, and
background!

Selecting this item opens the following sub-menu:

TOC Control Software Manual

3.

These items automatically scale the graph to maximize
the display of information. The X and Y axes can be auto-
scaled individually, or both axes can be adjusted.

Changing the Magnification

The graph can be magnified. To enlarge any portion of the
graph, drag a box around the area of interest. The area
inside the box expands to fill the graph window. Use
Limits (see above) to restore the original view.

Outlier Test

The third portion of the Injection Table shows the results
of the Outlier Test (Grubbs test).

Outliertest (Grubbs Tesh

tnjection No = 3

8D = 0,05937
Cv= 3,85%
Grubbs Value= 1,153
TestValue = 1,150

Deviation is not significant

The Qutlier test (Grubbs fest)

Outliers are values that lie outside the range of valid
results. These values can be excluded from calculation
with the Edit/Exclude command. The Grubbs test is used
to determine whether a value is far enough from the
mean to be considered an outlier. This test is performed in
both the Injection Table and the Statistics (Summary)
window.

When either of these windows is opened, an outlier test is
performed on the data and the results are displayed
(unless the display was turned off in the Display Options

. section of the Options menu). The test indicates whether
any of the data points in the sample run being examined
should be excluded.
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The TOC Control program uses the Grubbs Test for
evaluating outliers. In this method, the data points are
ranked in order, from X; to X, The mean (X) and
standard deviation (SD) are calculated using all the data
points. A value T is calculated according to the following
equation:

— _)—(:—Xl)
IfX,<Xx: m(—-—“

1 T D
fXi>x: 1o X -X)

SD

Xiis the dati point with the highest deviation from the
mean value X . '

The value T is then compared to the Grubbs value
(rM(£P), where f= number of data points, P = 95% ) from
the Grubbs table. If the test value T is larger than the
Grubbs value rM, the data point is considered an outlier.

Chapter Seven

‘Statistics Summary Table

The Statistics Summary Table makes statistical
comparisons among samples with the same Sample Name.
This is useful, for example, for identifying outliers, or
obtaining the mean area count, of all samples from a
particular sampling site.

To obtain the Statistics Summary table, open a Sample
Table, then select Statistics (Summary) from the View
menu. The Statistics Summary table window opens.

] Cnn.c;m.rétion .

Th

At the top of the table is the Sample Name drop down list.
Choose one of the Sample Names for statistical
comparison. All samples with the same Sample Name will
appear in the Statistics Summary window.

The window is divided into three sections: the table, the
graph, and the outlier test. Each section can be resized by
dragging the dividers with the mouse.
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Statistics Summary Table

1.

Statistics Table

The displayed columns can be customized by changing the
Display Settings for the Statistics Table (in the Options
menu).

To change the column width, hold the mouse over the
border on the title cell. The cursor changes to two lines
with arrows in the middle. Click, then drag the cell border
to the desired width.

To automatically adjust the column width to
accommodate the longest entry, double-click when the
cursor changes to two lines with arrows.

Type
The type (Unknown, Control, or Trk Control) of

sample is shown. This information comes from the
Sample Table.

Sample Name

The Sample Name (from the Sample Table) is
shown here. This should correspond to the Sample
Name chosen from the drop-down list at the top of

the window.

Sample ID
The Sample ID for the injections in the row (from
the Sample Table) is displayed.

Analysis
The type of analysis from the Sample Table is
shown.

Vial

The vial number for the sample injections is given.
This column does not appear for SSM
measurements.

No. of Injections

The number of injections per vial is displayed. This
information is from the Sample Table.
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No. of Washes

Sparge Time

Acid Addition

Dilution

nj. Vol.

SD

CV

The number of sample washes performed during
the injections is displayed (from the Sample Table).
This column does not appear for SSM
measurements.

The Sparge Time, if any, from the Sample Table is
shown. This column does not appear for SSM
measurements.

The amount of acid added Gf any) is shown in nL.
This information comes from the Sample Table.
This column does not appear for SSM
measurements,

The dilution factor, if any, from the Sample Table
15 given. Note that if the dilution factor is greater
than 1, the final concentration value has been
multiplied by this factor.

The injection volume for each injection is displayed
(this comes from the Sample Table). This column
does not appear for SSM measurements.

The standard deviation is calculated for each row.
Note that these values are the same as those of the
Sample Table.

The coefficient of variation is calculated for each
row. Note that these values are the same as those
of the Sample Table.
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Area

Conc

Unit

The average area count for all the injections in the
row is given. Note that these values are the same
as those of the Sample Table. At the bottom of the
column, the MV (Mean Value), SD (Standard
Deviation) and CV (Coefficient of Variation) for the
areas are given. This statistical information allows
comparison of the area counts for all the rows in
the column (all the samples with the same Sample

Name).

The average concentration for all the injections in
the row is given. Note that these values are the
same as those of the Sample Table. At the bottom
of the column, the MV (Mean Value), SD (Standard
Deviation) and CV (Coefficient of Variation) for the
areas are given. This statistical information allows
comparison of the concentration values for all the
rows in the column (all the samples with the same
Sample Name).

The unit of measurement is given. This comes from
the Sample Table.

Confidence Range

Amount [mg]

Volume [ul]

Abs C

The confidence range used for the statistical
analyses is given.

For SSM measurements, this is the sample amount
in mg. This comes from the Sample Table.

This is the volume of liquid sample introduced by
the SSM in pL, from the Sample Table.

For SSM measurements, this is the absolute carbon
value.
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Statistics Graph

The Statistics Summary graph window shows a plot of
concentration for each injection. If the graph is hidden,
enable the display in the Options/ Display Settings/
Statistics Table tab.

Each point on the graph represents one injection. Note
that outliers are indicated differently. Five lines on the
graph help with statistical interpretation: the mean, and
one and two times the standard deviation above and
below the mean.

The appearance of the graph can be customized, and more
detailed information about the graph can be obtained (see
p. 142)

Outlier Test

The third portion of the Statistics Summary Window
shows the results of the Qutlier Test (Grubbs test).

Outliertest (Grubbs Test

" Injection No = 3
D= 005937
CyV= 3,85%
Grubhs Value = 1,163
Test Value = 1,150

Daviation is not significant

The Outlier test (Grubbs test)

Outliers are values that lie outside the range of valid
results. These values can be excluded from calculation.
The Grubbs test is used to determine whether a value is
far enough from the mean to be considered an outher.
This test is performed in both the Injection Table and the
Statistics (Summary) window.

- When either of these windows is opened, an outlier test is

performed on the data and the results are displayed
(unless the display was turned off in the Display Options
section of the Options menu). The test indicates whether
any of the data points in the sample run being examined
should be execluded.
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